
 

 

 

Programa de Mestrado Profissional em Materiais 

 

Dissertação: 

 

“TÉCNICAS E IMPLEMENTAÇÃO DE ROTINAS PARA 

CARACTERIZAÇÃO MICROESTRUTURAL DE MATERIAIS 

COM GRÃOS EQUAXIAIS” 

 
 
 
 
 
 

Aluno: Luiz Fabiano Costa de Sá 
 
 
 
 
PUBLICAÇÃO 

XX 

 

Volta Redonda / RJ - Brasil  

FUNDAÇÃO OSWALDO ARANHA 

CENTRO UNIVERSITÁRIO DE VOLTA REDONDA  

 



2 

 

   

 

 

 
 

“TÉCNICAS E IMPLEMENTAÇÃO DE ROTINAS PARA 

CARACTERIZAÇÃO MICROESTRUTURAL DE MATERIAIS 

COM GRÃOS EQUAXIAIS” 

 

 

 

 

 
ALUNO: LUIZ FABIANO COSTA DE SÁ 

  
 
 
 
 
 
 
 
 

Dissertação apresentada ao 

Curso de Mestrado Profissional 

em Materiais do UniFOA para a 

obtenção do título de mestre em 

Materiais 

 
 
 

Orientador: Prof. Dr. José Vitor Candido de Souza 
 
 
 
 

VOLTA REDONDA -2011 



3 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A Deus, pela vida, esperança e estímulo 

nas horas mais difíceis. A minha família, 

em especial à minha esposa Débora, meus 

filhos Gustavo e Lucas, meus pais e 

irmãos, a quem devo tudo que sou e que 

me mostraram os caminhos dos valores 

éticos, morais, cristãos e da verdade e pelo 

carinho, compreensão, companheirismo 

dedicação. 

 



4 

 

   

AGRADECIMENTOS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A realização deste trabalho só foi possível 

graças à colaboração direta ou indireta de 

muitas pessoas, especialmente aos 

professores Doutores José Vitor Candido de 

Souza, Claudinei dos Santos e Daniela 

Regina Mollinari. Agradecimentos profundos 

e sinceros a todas elas que, de alguma 

forma, contribuíram no sentido de atingir 

esta importante meta de minha vida, a 

dissertação de mestrado.  

 



5 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

O limite real de um homem 
termina quando começa a sua imaginação. 

Autor: Anônimo 



6 

 

   

FOLHA DE APROVAÇÃO 

 
 
 
 
 
 
 
 

Aluno: 
 

Luiz Fabiano Costa de Sá 
 
 
 
 
 

Orientador: 
 

Prof. Dr. José Vitor Candido de Souza 
 
 
 
 

Título de Dissertação: 

“TÉCNICAS E IMPLEMENTAÇÃO DE ROTINAS PARA CARACTERIZAÇÃO 

MICROESTRUTURAL DE MATERIAIS COM GRÃOS EQUAXIAIS” 

 
 
 
 

Banca Examinadora: 
 
 
 

___________________________________________________ 
Prof. Dr. Olivério Moreira de Macedo Silva  

 
 
 

___________________________________________________ 
Prof. Dr. Claudinei dos Santos 

 
 
 

___________________________________________________ 
Profa. Dra. Daniela Regina Mullinari 



7 

 

   

SUMÁRIO 

 
Lista de Figuras .................................................................................................................................... 9 

Lista de Tabelas ................................................................................................................................. 11 

RESUMO ............................................................................................................................................. 13 

Abstract ................................................................................................................................................ 14 

CAPÍTULO 1 ....................................................................................................................................... 15 

Introdução ............................................................................................................................................ 15 

1.1. Objetivo do Trabalho .................................................................................................................. 17 

1.3. Justificativa .................................................................................................................................. 18 

CAPÍTULO 2 ....................................................................................................................................... 19 

REVISÃO BIBLIOGRÁFICA ............................................................................................................. 19 

2.1. Materiais Cerâmicos ................................................................................................................... 19 

2.2 Cerâmicas à Base de Zircônia ................................................................................................... 20 

2.3. Transformação Martensítica ( t  m)...................................................................................... 21 

2.4. Aplicações de Cerâmicas à Base de Zircônia ........................................................................ 23 

2.5. Características de Imagem Obtidas por MEV ........................................................................ 24 

2.6. Pré-Processamento de Imagem ............................................................................................... 27 

2.7. Modificação de Histograma de uma Imagem ......................................................................... 28 

2.8. Processamento de Imagem ...................................................................................................... 30 

2.9. Digitalização ................................................................................................................................ 31 

2.10. Textura de uma imagem.......................................................................................................... 32 

2.11. Limiarização .............................................................................................................................. 33 

2.12. Métodos de Contagem de Grãos ........................................................................................... 34 

2.13. A Análise Automática de Imagens ......................................................................................... 36 

2.14. Software ImageJ (NIH Image J) ............................................................................................. 37 

2.15. Análise de Tamanhos de Grãos por Diâmetro de Feret ..................................................... 38 

CAPITULO 3 ....................................................................................................................................... 40 

MATERIAIS E MÉTODOS ................................................................................................................ 40 

3.1. Materiais ....................................................................................................................................... 40 

3.2. Propriedades das Cerâmicas a Base de Zirconia ................................................................. 40 

3.3. Análise das Microestruturas por MEV ..................................................................................... 41 

CAPITULO 4 ....................................................................................................................................... 43 

RESULTADOS .................................................................................................................................... 43 

4.1 Implementações de Plugins ....................................................................................................... 43 



8 

 

   

4.1.1 Circularidade (Circularity) ........................................................................................................ 43 

4.1.2 – Barra de Escala (ScaleBar.java) ......................................................................................... 44 

4.1.3 – Área dos Grãos (Feret) ........................................................................................................ 45 

4.1.4- Analise da Implementação dos Plugins no Software Livre ImageJ ................................ 46 

4.2. Análise da Qualidade das Imagens Através de Histogramas ............................................. 47 

4.3. Pré-Tratamento das Imagens Utilizando Software de Edição de Imagem ........................ 51 

4.4. Aplicando Filtro Thresholding nas Imagens das Cerâmicas ................................................ 55 

4.5. Transformação das Escalas...................................................................................................... 57 

4.6. Quantificação e Qualificação dos Grãos ................................................................................. 59 

CONCLUSÃO ..................................................................................................................................... 66 

Referências Bibliografias ................................................................................................................... 67 

APÊNDICE 1 ....................................................................................................................................... 71 

APÊNDICE 2 ....................................................................................................................................... 89 

 



9 

 

   

Lista de Figuras 

Figura 1 - Representações esquemáticas das três fases da zircônia cristalina: (a) cúbica, (b) 

tetragonal, (c) monoclínica.[25] ........................................................................................................ 22 

Figura 2 - Volume de interação do feixe de elétrons do microscópio eletrônico de varredura 

[29] ........................................................................................................................................................ 26 

Figura 3- Relação entre Visão por Computador, Processamento Digital de Imagens e 

Computação Gráfica [30]. ................................................................................................................. 27 

Figura 4– Mostra os histogramas correspondentes aos principais tipos de imagens: (a) 

imagem escura; (b) imagem clara; (c) imagem de baixo contraste e (d) imagem de alto 

contraste. [31] ..................................................................................................................................... 29 

Figura 5-(a) Imagem bidimensional em tons de cinza, e (b) escala em tons de cinza com 

valores atribuídos ao brilho em cada ponto. .................................................................................. 31 

Figura 6 - Ambiente de trabalho ImageJ ........................................................................................ 38 

Figura 7 - (a) projeção planar do grão; (b)projeção das retas tangenciadas sobre a imagem 

planar de um grão .............................................................................................................................. 38 

Figura 8 -  amostras sinterizadas as temperaturas de (a) 1450 °C – 4h, (b) 1500 °C – 2h, (c) 

1530 °C – 4h, (d) 1530 °C – 2h, (e) 1600 °C – 4h e (f) 1450 °C – 2h ........................................ 42 

Figura 9 (f) e 9(f’) podemos observar a imagem original e seu histograma. ............................ 50 

Figura 10 (a) à (f) e (a’) à (f’) - imagens de amostras com contorno delineado e seu 

histograma. .......................................................................................................................................... 54 

Figura 11 (a) à 11(f) - mostram as imagens da microestrutura tratada com o filtro 

thresholding ......................................................................................................................................... 56 

Figura 12 - (a) imagem da amostra com barra de escala selecionada (b) seletor utilizado na 

barra de escala. .................................................................................................................................. 58 

Figura 13  - Modelo de aplicação de comando de análise de partículas .................................. 59 

Figura 14 – (a) à (f) imagens com contorno segmentado e grãos identificados 

numericamente (a’) à (f’) – planilha com valores das frações volumétricas ............................. 63 

Figura 15 (a) à (f) – gráficos de distribuição de tamanho de grão .............................................. 65 

Figura 16:(a)Imagem da amostra original obtida do MEV; (b) Amostra com contorno de grão 

realçado através do editor de imagem Paint.................................................................................. 72 

Figura 17: (a) acesso ao menu de comando de conversão para RGB Color; (b) comando 

RGB Stack ........................................................................................................................................... 73 

Figura 18: Amostra com as camadas de cores separadas ......................................................... 74 



10 

 

   

Figura 19: acesso ao menu de comando Image -> Stacks -> Delete Slice  que exclui a 

camada de cor. ................................................................................................................................... 75 

Figura 20: Amostra com recurso de inversão de cores para realce do contorno do grão ...... 76 

Figura 21: acesso ao comando de binarização ............................................................................. 77 

Figura 22: (a) Amostra binarizada e ainda com ruídos e (b) ferramenta de variação de 

intensidade da cor. ............................................................................................................................. 78 

Figura 23: Amostra binarizada e corrigida pela intensidade de cor. .......................................... 78 

Figura 24: (a) Amostra Original com barra de escala e menu de acesso ao comando de 

criação de escala; (b) Caixa de diálogo onde é criada a escala ................................................. 80 

Figura 25: Ferramenta de traçado reto para criação da escala para a amostra ...................... 81 

Figura 26: Caixa de diálogo preenchida com os valores de medida para a amostra em uso.

 ............................................................................................................................................................... 81 

Figura 27: (a) acesso ao comando onde são selecionadas as opções de resultado; (b) caixa 

de diálogo de resultados a serem mostrados ................................................................................ 83 

Figura 28: (a) acesso ao comando onde é acessada a ferramenta que contém as opções de 

resultado; (b) caixa de diálogo de resultados a serem mostrados ............................................. 84 

Figura 29: (a) Planilha de resultados (b) grãos com contorno realçados e indexados ........... 86 

Figura 30: Planilha de resultados com o menu selecionado ....................................................... 86 

Figura 31: Caixa de diálogo para seleção de distribuição desejada .......................................... 87 

Figura 32: Janela portadora do gráfico de distribuição de Feret ................................................ 88 

Figura 33: Janela com os valores utilizados para criar o gráfico de distribuição de Feret ..... 88 



11 

 

   

Lista de Tabelas 

Tabela 1 - mostra as propriedades física e mecânica das amostras                       41 



12 

 

   

LISTA DE ABREVIATURAS 
 

MEV – Microscópio Eletrônico de Varredura 

NIH - National Institute of Health 

Ms - transformação martensítica 

PSZ - zircônia parcialmente estabilizada (Partially Stabilized Zirconia) 

TZP - zircônia tetragonal policristalina (Tetragonal Zirconia Polycrystalline) 

MET - Microscopia Eletrônica de Transmissão  

MF - Microscopia Fotônica 

MO - Microscópio Óptico 

RGB – Vermelho-Verde-Azul (Red-Green-Blue) 

ROI - Interface retangular ou oval (retangular oval interface) 



13 

 

   

RESUMO 

A pesquisa desenvolvida para reconhecimento e definições de uma 

microestrutura de um determinado material, ainda possui muitos desafios a serem 

superados. As realizações de análises de imagem das microestruturas, ainda são 

objeto de muitas controvérsias na área de engenharia e ciência dos materiais. O 

presente trabalho tem por objetivo desenvolver e aprimorar ferramentas do software 

livre ImageJ por meio de mudanças no código fonte, implementação de rotinas e 

técnicas de aplicações de forma a assegurar as análises quantitativas e qualitativas 

das microestrutura dos materiais. A pesquisa culminou no estudo de microestruturas 

de cerâmicas a base de zircônia produzida pela empresa ProtMat, e sinterizadas nas 

temperaturas de 1450, 1500, 1530 e 1600 °C/ 2 e 4h, obtidas por Microscopia 

Eletrônica de Varredura (MEV). Inicialmente utilizou-se o programa de análise de 

imagens software livre ImageJ para para definir a qualidade das imagens. As 

imagens com baixa qualidade foram submetidas ao tratamento pelo software 

Microsoft Paint para realce dos contornos de grãos. Posteriormente as imagens 

foram submetidas análise usando o software livre ImageJ para remoção de ruídos e 

definição das regiões de interesse para análise. Na sequencia consistiu-se das 

análises quantitativas e qualitativas criando rotinas de análise, e implementação de 

mudanças no código fonte que permite as imagens serem analisadas 

estatisticamente. Os resultados mostraram que as mudanças no código fonte 

promoveram uma melhor eficiência das análises, enquanto que a incorporação de 

rotinas e técnicas promoveu eficientes resultados de análise microestrutural dos 

materiais, com determinação das dimensões e quantidades de grãos por áreas. A 

utilização de análise de imagem automatizada gerou resultados quantitativos e 

qualitativos das microestruturas, com grande rapidez e precisão sem interferência do 

operador. Esses resultados permitem uma estimativa das propriedades física e 

mecânica dos materiais. A metodologia desenvolvida e utilizada nesse trabalho 

promove uma melhor eficiencia do software livre ImageJ na aplicação das mais 

distintas áreas, com resultados importantes e seguros. 

  

Palavras-chave: novas interfaces; grãos equaxial; Análise microestrutural; Software 

ImageJ ; e processamento de análises digitais. 
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Abstract  

The development of research to regnicion and definition the microstructure of 

materials, it still has chellenge to overcome. The achievements of image analysis on 

microstructures, still are subject at many controversies in the field of the engineering 

and materials science. In the present work has as objective at develop and improve 

the tools free software ImageJ by changes in the source code, new routines and 

techniques implementation to ensure the quantitative and qualitative analysis of the 

materials microstructure. The research has been culminated in the study on zirconia-

based microstructures ceramics produced by the ProtMat company and sintered at 

temperatures of 1450, 1500, 1530 and 1600 °C for 2 and 4 h, obtained by Scanning 

Electron Microscopy (SEM). Initially used the image analysis program free software 

ImageJ to define the quality images. The images with low resolution to has been 

submited at tratment by software Microsoft Paint for enhance grain boundaries. Later 

on the imagens were submited at  free software ImageJ for removing noise and 

showing regions of microstructural interest. In the sequence has been applied 

quantitative and qualitative analysis, development new routines with changes 

implementing into source code which allows the images to be analyzed statistically. 

The results showed that changes in the source code promoted a better efficiency of 

the analysis, while the incorporation of new routines and techniques promoted 

efficient results of microstructural analysis in materials with grain size determination 

and quantities of grains per area. The use of automated image analysis generated 

quantitative and qualitative results of microstructures, with great speed and accuracy 

without operator intervention.  

These results, allow an estimate of the physical and mechanical properties of 

materials. The methodology developed and used in this work allows the use of free 

software ImageJ in the application of the most distinct areas, with important results 

and insurance.  

 

Keywords: New interfaces and equaxial grain; Microstructural analysis; Software 

ImageJ; and digital image analysis. 
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CAPÍTULO 1 

 

Introdução 

O desenvolvimento de novos materiais para as mais diversas aplicações têm 

sido objeto de importantes pesquisas realizadas por pesquisadores em todo mundo, 

com objetivo de atender as novas implicações dos mercados.  

 

A crescente evolução tecnológica e o recente desequilíbrio observado na 

natureza trouxeram aos olhos do mundo a necessidade de novos desafios que 

permita novos caminhos, aprimorando técnicas, produzindo novos materiais e novos 

conceitos de caracterizações. Mas o desenvolvimento sistemático de novos 

materiais depende fortemente de sua caracterização em diversos níveis de 

resolução. Estrutura, microestrutura, fases, e geometria de defeitos, assim como 

composição química e distribuição espacial, que são parâmetros importantes para 

se determinar o comportamento de materiais em diversas aplicações [1]. 

 

A determinação manual do tamanho de grãos e fração volumétrica de fases 

pode ser uma tarefa laboriosa, geralmente sujeita a erros do operador. Como 

alternativa para minimizar tais erros e diminuir o tempo de análise, o uso de 

programas computacionais de análise de imagem têm sido cada vez mais comuns. 

Dentre os diversos programas disponíveis no mercado, com custos variáveis, o 

ImageJ tem se destacado. ImageJ é um programa de domínio público desenvolvido 

pelo National Institute of Health, NIH, nos Estados Unidos. Por ser de domínio 

público possui seu código aberto possibilitando que a comunidade de usuários 

desenvolva complementos e modificações de acordo com suas necessidades [2]. 

 

O Processamento digital de imagens, sem dúvida, é uma área em constante 

crescimento. O interesse em suas aplicações vem principalmente de duas áreas: 

melhoria na informação da imagem para interpretação humana, e o processamento 

de imagens em computador, para análise quantitativa, qualitativa e sua correlação 

com as propriedades representando um recurso indispensável em diferentes ramos 

da ciência e tecnologia, como: ciência dos materiais, na medicina, na física, na 

engenharia, e outros. 
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Para realizar a análise de uma imagem é preciso ter-se um sistema de 

classificação, que usa obter informações suficientes para diferenciar regiões de 

interesse e/ou definir um conjunto de características capazes de descrever de 

maneira efetiva cada região contida em uma imagem. Para isso se faz necessário 

tratar a imagem evidenciando as regiões de interesse de maneira que o programa 

possa realizar a análise. O tratamento de imagem se dá por operações de matrizes 

que alteram o valor de seus pixels. Pixels são elementos da imagem e possuem 

posição e valor de brilho definidos, formando uma matriz correspondente à imagem. 

Existem diversas operações já descritas na literatura e a aplicação consecutiva de 

diferentes operações, ou filtros, podem levar ao mesmo resultado. Desta maneira, a 

experiência do operador e o conhecimento básico dos filtros são importantes para se 

desenvolver um algoritmo para evidenciar as regiões de interesse da imagem [3]. 

 

Existe uma gama de aplicações na análise digital de imagens, sendo já 

bastante utilizada no controle de qualidade na produção de aços, determinando-se 

tanto o tamanho médio de grãos quanto a quantidade de inclusões presentes. Em 

sistemas cerâmicos informações como tamanho de grão, porosidade, quantidade e 

disposição de fases podem ser obtidas para se determinar, por exemplo, a 

temperatura ideal de sinterização, presença de fases deletérias a propriedades de 

interesse, defeitos inseridos durante o processamento, entre outros, quantificando as 

correlações entre microestrutura, processamento e propriedades [4-10]. 

 

No caso do decorrente trabalho, foi utilizada cerâmica à base de zircônia que 

passa por transformações de fase até seu ponto de fusão, podendo existir em três 

diferentes fases. A baixa temperatura, a fase estável é monoclínica e é transformada 

em fase tetragonal quando é aquecida a 1170 °C. Esta estrutura tetragonal é 

transformada em fase cúbica novamente quando as amostras são aquecidas a 2370 

°C. Essas transformações são acompanhadas por uma mudança do volume da 

célula unitária, que em aplicações estruturais é usada para melhorar as 

propriedades mecânicas deste material [11]. As fases obtidas em altas temperaturas 

podem ser estabilizadas em baixas temperaturas quando a zircônia é dopada com 

cátions que possuem valência baixa como, por exemplo, os alcalinos terrosos Mg2+, 

Ca2+ e cátions com terras raras TR3+ e Y3+ que se incorporam à estrutura cristalina 

da zircônia estabilizando as estruturas tetragonais e cúbicas da zircônia [12]. 
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O grande range de aplicação de cerâmicas à base de zircônia (ZrO2) vem 

sendo ampliado por suas excelentes propriedades [13].  A zircônia estabilizada com 

ítria (Y-TZP) se tornou uma alternativa popular a aplicações como cerâmica 

estrutural uma vez que é também um agente tenacificante e apresenta maior 

resistência à flexão, maior tenacidade à fratura e menor módulo de elasticidade [14]. 

Diante das propriedades evidentes da zircônia vários sistemas matriz cerâmica-

zircônia têm sido estudados com objetivo de equalizar microestrutura e propriedades 

que promova a transformação induzida por tensão da fase tetragonal para fase 

monoclínica das partículas de zircônia, a qual é acompanhada de uma expansão 

volumétrica (3 a 6%) [15]. Essa transformação absorve parte da energia necessária 

para a propagação da trinca, ocorrendo um aumento da tenacidade à fratura. 

 

1.1. Objetivo do Trabalho 

O foco fundamental desse trabalho é a utilização de técnicas de 

processamento e análise digital de imagens para quantificar e qualificar uma 

microestrutura a partir de sua obtenção em um microscópio. É proposto um método 

para rotina e análise de microestruturas utilizando o software ImageJ. 

 

Os objetivos deste trabalho são o desenvolvimento e implementação de 

novas interfaces e rotinas para análise de texturas com uso de métodos 

quantitativos (contagem de grãos) e qualitativos (área e diâmetro), que possibilitem a 

identificação das características microestruturais dos materiais: 

 

- quantificar e qualificar os grãos obtidos das microestruturas das cerâmicas 

à base de zircônia;  

 

- Relacionar os tamanhos de grãos com as temperaturas de sinterização; 

 

- Implementar novas interfaces ao software ImageJ para facilitar o processo 

de contagem e dimensões dos grãos;  

 

- Construir um manual de uso prático permitindo uma maior facilidade de dos 
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usuários na rotina de análise de microestruturas utilizando o software ImageJ.  

 

1.3. Justificativa 

O uso software livre ImageJ em processamento digital de imagens possibilita 

um melhor realce das microestruturas trabalhadas, logo, o processamento digital de 

imagens visa a manipulação e análise da informação pixel a pixel pelo computador, 

além disso, também permite auxiliar na busca por informações que não estão 

explicitas a olho nu. 

 

Através deste software é possível fazer uma consideração das propriedades 

dos materiais usando análise qualitativa e quantitativa. A utilização do software 

ImageJ em diversas áreas pode ser considerada um fato comum. Entretanto na 

maioria das áreas essa análise são fitas em uma estrutura monocristalina o que 

facilita o uso das ferramentas. Nas engenharias o uso desse software é incompleto 

devido a microestruturas policristalinas (diferentes tamanhos e formas de grãos) 

fazendo necessário a criação de novas interfaces e rotinas de análise. Atualmente o 

uso de aplicação desse software se dá em:  

 

- Biologia, na análise automática de amostras biológicas (análise de 

espécimes); 

 

- Defesa/Inteligência, interpretação automática de imagens obtidas por 

satélite, caracterização da superfície do satélite após colisão com micrometeoritos; 

 

- Industrias, nas análise microestrutural das falhas ocorridas durante os 

processo; 

 

- Apoio da Lei, na identificação de pessoas. 
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CAPÍTULO 2 

 

REVISÃO BIBLIOGRÁFICA 

  

2.1. Materiais Cerâmicos  

Os cerâmicos são os mais antigos, mas somente a partir da década de 70 as 

os estudos em matérias cerâmicos têm alcançado uma certa evolução. 

 

Nos últimos anos tem-se observado desenvolvimento de novos materiais 

cerâmicos, motivado pela demanda de produtos que executem novas funções de 

maneira segura, e que apresentem uma crescente evolução tecnológica e científica.  

 

Pesquisas realizadas em materiais cerâmicos em todo mundo tem como 

objetivo atender as mais novas solicitações de mercado. Os materiais cerâmicos 

vêm experimentando diversas aplicações com uma contínua evolução como 

componentes estruturais nas indústrias aeronáuticas, aeroespaciais, nucleares, 

biomédicas, petroquímicas, automotivas, e outras [16]. 

 

Qualificado como material do mundo moderno os materiais cerâmicos 

tiveram evolução significativa a partir da década de 80, onde as cerâmicas 

avançadas têm alcançado resultados promissores em suas propriedades. Os 

materiais cerâmicos são partes de uma tecnologia viabilizadora de produtos e 

equipamentos de ponta, promovendo um grande efeito multiplicador na economia 

com alto índice de alavancagem, ou seja, cada unidade monetária investida nesses 

materiais viabiliza ou exerce forte influência em um mercado de produtos onze vezes 

maior [17].  

 

Mesmo com os recentes avanços alcançados, ainda existem muitas 

restrições quanto a suas aplicações, devido às dificuldades que se referem ao 

aumento da tenacidade à fratura, diminuição da quantidade e do tamanho de 

microdefeitos e diminuição do grau de dispersão de valores de resistência mecânica. 
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Isso afeta diretamente a confiabilidade desses materiais sujeitos as intensas 

solicitações mecânicas quando de suas aplicações, sendo a fragilidade a 

característica limitante desses materiais na aplicação em substituição aos metais. 

  

Os materiais cerâmicos podem romper-se drasticamente após terem sofrido 

pequena ou nenhuma deformação plástica. Entretanto um novo caminho começa a 

mostrar que pode ser possível desenvolver cerâmicas com alto grau de 

confiabilidade utilizando-se nanociência. 

 

A nanociência tem permitido melhor controle de suas propriedades físicas e 

mecânicas, fundamentado no controle da microestrutura, tais como: porosidades, 

tamanhos e distribuição dos grãos, fases presente, etc [17].  

  

2.2 Cerâmicas à Base de Zircônia 

A zircônia, ou óxido de zircônio, é um material cerâmico excepcional devido 

principalmente ao grande número de possíveis aplicações. Desde a metade do 

século 20 a zircônia (ZrO2) tem atraído a atenção de um grande número de 

pesquisadores e, atualmente, o conhecimento deste material é substancial, assim 

como suas aplicações nas mais diversas áreas [18]. Suas principais propriedades 

são o alto ponto de fusão 2700 ºC, a resistência à corrosão, a baixa condutividade 

térmica, a alta resistência mecânica e à abrasão, alta tenacidade, resistência ao 

choque térmico, alto índice de refração e boa condutividade Iônica [19].  

 

O óxido de zircônio puro passa por transformações de fase até o seu ponto 

de fusão. A transformação ocorre por processo sem difusão, não é termicamente 

ativada, é uma transformação militar, onde a quantidade transformada não depende 

do tempo, para uma dada temperatura, uma fração da fase original se transforma 

rápido, cessando a transformação, a fração transformada é função da temperatura, a 

velocidade da transformação é alta, não há mudança de composição do produto 

formado [20].  A transformação é termodinamicamente reversível a T=1170 °C [21], 

a mudança de posição atômica é feita bruscamente, possuindo uma curva histerese 

térmica entre ciclos de resfriamento e aquecimento. A transformação inicia-se no 

ciclo de resfriamento à temperatura de transformação martensítica (Ms) que, para 
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monocristais de ZrO2 ou corpos densos de ZrO2 policristalina, situa-se entre 950 e 

850 °C.  O valor de Ms é influenciado por diversos parâmetros, tamanho, formato e 

localização (inter ou intragranular) das partículas de ZrO2, quantidade de óxidos 

estabilizadores, diferença de coeficiente de dilatação térmica, e outros [22]. 

 

Um dos sistemas mais difundidos e utilizados é o sistema ZrO2-Y2O3 que 

tem como característica mais importante o decréscimo da temperatura de 

transformação tetragonal-monoclínica com o aumento da quantidade de ítria. 

(eutetóide a 4,6% mol).  Com isso, partículas maiores de zircônia estabilizada 

podem ficar retidas na forma tetragonal metaestável [15].  

 

A adição de óxido de ítrio na zircônia inibe a transformação martensítica. O 

decréscimo da temperatura de transformação com adição de ítria produz uma menor 

mudança na temperatura e menos deformação térmica [23].  

 

A estabilização da fase tetragonal é afetada pelo tamanho de partícula e 

pelo módulo de elasticidade do compósito, assim como, no caso do grão de zircônia 

quando isolado, a transformação T→M ocorre uma vez que as condições de 

nucleação sejam atingidas. No entanto, quando este grão está imerso em uma 

matriz, a variação de volume (3-6 %) e a deformação associada a esta 

transformação não podem ser aliviadas por mecanismos difusionais, mas devem se 

acomodar por deformação plástica ou elástica na região próxima ao grão. 

Consequentemente surge uma energia de deformação associada ao grão e a matriz 

na vizinhança do grão. A produção desta energia de deformação, que resulta na 

compressão da partícula, adiciona um termo extra à energia livre do sistema, 

tornando a transformação menos provável. Para que esta transformação prossiga, o 

sistema deve ser superresfriado a fim de aumentar a força motriz química para a 

transformação. Para que a fase tetragonal seja retida, é necessário o controle de 

fatores microestruturais (tamanho de grão) e químicos (teor de oxido estabilizante). 

 

2.3. Transformação Martensítica ( t  m) 

O polimorfismo da zircônia é uma importante característica desse material, 

com aplicações nas mais diversas indústrias como: aeronáuticas, aeroespaciais, 
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nucleares, biomédicas, petroquímicas, automotivas, etc. Durante o aquecimento, a 

zircônia passa por um processo de transformação de fase. A zircônia apresenta três 

formas polimorfas, uma estrutura monoclínica estável, até aproximadamente 1170 

ºC, onde ocorre uma transformação de natureza martensítica tetragonal, a qual é 

estável até aproximadamente 2370 ºC, ocorrendo nova transição agora para a 

estrutura cúbica, qual é estável até próximo ao ponto de fusão de 2700 ºC, Figura 1. 

A mudança em volume associada a essas transformações pode provocar tensões 

externas e até mesmo fratura do material, tornado impossível o uso da zircônia pura 

em muitas aplicações [24]. 

 

A estabilização da zircônia pode ser feita total ou parcialmente, por meio 

da adição de óxidos CaO, CeO2, MgO, Y2O3 e outros que atuam como 

estabilizadores da forma cristalográfica cúbica desde a temperatura ambiente até 

sua fusão. A zircônia pode ser dividida em duas categorias: i) zircônia parcialmente 

estabilizada (PSZ - Partially Stabilized Zirconia), que contém aditivos estabilizantes 

suficientes para permitir a formação de precipitados de zircônia tetragonal em uma 

matriz cúbica, consistindo em quantidades maiores que 4 % em mol de Y2O3; e ii) 

zircônia tetragonal policristalina (TZP - Tetragonal Zirconia Polycrystalline), com 

quantidade próxima de 100 % da fase cristalina tetragonal na temperatura ambiente, 

com teores de Y2O3 comumente estabelecido em 3 % em mol.[6,14,15]. A Figura 1, 

apresenta as três formas polimorfas da zircônia. 

 

 
Figura 1 - Representações esquemáticas das três fases da zircônia cristalina: (a) cúbica, (b) 

tetragonal, (c) monoclínica.[25] 
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2.4. Aplicações de Cerâmicas à Base de Zircônia 

Com o atual avanço tecnológico, as mais diversas áreas têm sofrido 

alterações em seus projetos, sendo estas as necessidades: novos materiais¸ design 

e tecnologias. Fato preponderante é que os seguimentos de novas tecnologias 

trabalham em sistemas preditivos, sendo assim materiais que tenham tempo de vida 

pré-determinado são necessários para sua preventiva confiabilidade. Dentre os 

materiais, as cerâmicas estruturais de altos desempenhos mecânicos podem 

apresentar características promissoras na substituição de materiais convencionais. 

Para isso, cerâmicas estruturais com propriedades mecânicas compatíveis a certas 

utilizações, necessitam apresentar como aspectos microestrutural as características: 

composição e homogeneidade, distribuição do tamanho, e forma dos grãos e de 

poros adequadas. Sendo que o principal objetivo obter cerâmicas com baixa 

concentração de defeitos possíveis, a fim de garantir a sua confiabilidade e 

reprodutibilidade das propriedades no desempenho do produto cerâmico final. 

 

Nesse seguimento as cerâmicas a base de zircônia têm despertado 

interesse científico e tecnológico como material estrutural e funcional devido às suas 

excelentes propriedades. Grandes aplicações de cerâmicas a base de zircônia se 

encontram no seguimento de aplicação, como: sensores de oxigênio, cerâmicas 

eletrônicas, condutores iônicos, catálise heterogênea, tecnologia de filmes finos, 

sensores de humildade, ressoadores dielétricos, ferramentas de corte, implante [26]. 

 

Devido às suas propriedades as cerâmicas à base de zircônia se 

apresentam como materiais promissores à substituição de materiais convencionais 

em diversas aplicações. Dentre as variadas áreas de aplicação dessas cerâmicas as 

de implante têm apresentado um crescimento exponencial em aplicações com uso 

de zircônia, devido a essas serem leves, fortes, resistentes à corrosão e oxidação e 

capazes de resistir a ambientes que alternem diferentes temperaturas. 

Recentemente grande evolução nas técnicas de restauração dentária têm sido 

estabelecida pelo uso de materiais cerâmicos[27]. 

 

Esses materiais apresentam vantagens relativas, devido ao ótimo 
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desempenho das suas propriedades funcionais, principalmente estética, 

biocompatibilidade e resistência química. As cerâmicas de zircônia vêm se 

apresentando como um dos materiais cerâmicos que possui forte tendência ao 

implante dentário, devido à possibilidade da eliminação da subestrutura metálica das 

restaurações, inclusive das restaurações sobre implantes, visando uma melhor 

estética e utilizando para isso cerâmicas de maior tenacidade à fratura, minimizando 

a sua fragilidade. 

 

A implantodontia é a especialidade da odontologia que visa à reposição de 

elementos dentários perdidos ou removidos, sendo que a estética tem grande 

importância na vida social das pessoas. Porém o aumento de uso de componentes 

cerâmicos apresenta limitações mecânicas, devido à fragilidade das cerâmicas, fato 

que ajuste de propriedades da microestrutura pode melhorar. Atualmente a zircônia 

estabilizada com ítria (Y-TZP) se tornou uma alternativa popular como cerâmica 

estrutural uma vez que é também inerte em meio fisiológico, apresenta alta 

resistência à flexão, alta tenacidade à fratura e menor módulo de elasticidade, 

quando comparado aos outros materiais cerâmicos [14]. Além de suas propriedades 

mecânicas, a zircônia torna-se esteticamente bastante interessante quando polida. 

 

2.5. Características de Imagem Obtidas por MEV  

Na projeção de uma imagem por MEV a relação entre objeto e imagem é 

temporal, ou seja, depende diretamente do mapeamento ponto a ponto do espaço 

objeto, enquanto na projeção paralela existe uma relação geométrica entre o objeto 

e sua imagem, através da lente. Outra vantagem da formação de imagens por 

varredura está na formação serial da imagem, que permite diretamente o 

arquivamento e processamento eletrônico da mesma, com a redução de ruído e a 

melhoria de contraste.  

 

Conceitos como resolução e aumento também são interpretados de outra 

forma. O aumento é obtido simplesmente pela relação entre dimensão do monitor e 

da região varrida pela sonda, enquanto a resolução está relacionada com a 

dimensão da sonda, que idealmente deverá ser a menor possível. Os microscópicos 

eletrônicos de varredura apresentam as seguintes características:  
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 Obtenção de imagens de superfícies polidas ou rugosas, com grande 

profundidade e alta resolução;  

 

 Fácil interpretação das imagens, com aparência tridimensional;  

 

 Aquisição de sinal digital, possibilitando processamento de sinais, 

manipulação e processamento das imagens.  

 

O MEV tem sua maior aplicação no exame de superfícies rugosas, devido à 

fácil visualização e interpretação das imagens, embora, a utilização de diversas 

formas de interação entre elétrons e a matéria, permitam a aquisição de muitas 

outras informações, tal como diferenciação entre elementos, orientação cristalina, 

potenciais elétricos e magnéticos entre outros. 

  

A interação entre elétrons e matéria também é fator determinante na 

diferenciação entre MEV e outras técnicas de microscopia. O que na microscopia 

eletrônica de transmissão (MET) e na microscopia fotônica (MF) as imagens são 

ditas “diretas”, visto que os raios atravessam a amostra e passa por lentes, formando 

uma imagem real em uma tela ou virtual em uma ocular, o MEV origina imagens 

“indiretas”, isto é, não existe um caminho ótico entre a amostra e a imagem, sendo 

separados os sistemas de geração e visualização da imagem [28,29].  

 

A formação da imagem depende do mapeamento das interações que 

ocorrem entre elétrons e a superfície da amostra. Para tal, a superfície é varrida por 

um feixe de elétrons colimado (elétrons primários) e, a intensidade dos sinais 

secundários originados é medida por um tubo de raios catódicos, formando assim a 

imagem.  

 

Os sinais do MEV não são gerados apenas na superfície da amostra. O 

limite de resolução é determinado pelo diâmetro da região da amostra que, excitado 

pelo feixe primário, emite o sinal considerado. Os elétrons primários penetram na 

amostra a partir da área de incidência do feixe e são progressivamente espalhados, 
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interagindo num determinado volume de interação. Os elétrons primários penetram 

em todo o volume de interação, gerando diferentes sinais secundários usados para 

obter informação. A energia de cada elétron secundário determina a sua 

“profundidade de escape”. Este volume de interação depende da tensão de 

aceleração dos elétrons primários, do número atômico dos constituintes da amostra 

e, sobretudo do diâmetro do feixe primário. Uma representação do volume de 

iteração é mostrada na Figura 2 [28,29]. 

 

 

Figura 2 - Volume de interação do feixe de elétrons do microscópio eletrônico de varredura [29] 

 

O processamento de imagens digitais é a modificação de uma imagem 

original que fora adquirida por meio de diferentes sistemas de formação ou e 

digitalização de imagens como o Microscópio Eletrônico de Varredura (MEV) ou o 

Microscópio Óptico (MO), onde são eliminados os defeitos existentes na imagem e 

feita à identificação dos objetos para análise. Sendo o processamento dividido em 

um pré-processamento, uma segmentação e por fim o pós-processamento em que 

são envolvidas técnicas de realce de contrastes e de remoção de ruído. Estas 

etapas são necessárias para busca de melhoria da imagem com a intenção de 

aumentar e aperfeiçoar o sucesso dos processos seguintes. 

 

Visão por Computador, Processamento Digital de Imagens e Computação 

Gráfica são processos que lidam com imagens e informações nela contida. A 
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diferença entre estes processos pode ser vista na representação dos dados de 

entrada e saída de cada um dos processos, mostrados na Figura 3 [30].  

 

As áreas de Visão por Computador, Processamento de Imagens e 

Computação Gráfica vêm apresentando expressivo desenvolvimento nas últimas 

décadas. Tal crescimento pode ser detectado na área acadêmica, onde o assunto é 

objeto de pesquisas, teses e dissertações; na esfera industrial, onde a cada dia 

aumenta o número de empresas que produzem, comercializam e utilizam soluções 

de Processamento Digital de Imagens em seus processos; e na vida cotidiana, com 

a popularização dos computadores pessoais e das aplicações multimídia [31]. 

 

 

Figura 3- Relação entre Visão por Computador, Processamento Digital de Imagens e Computação 

Gráfica [30]. 

 

2.6. Pré-Processamento de Imagem 

Para ser realizada a análise quantitativa e qualitativa de uma imagem, faz-se 

necessário um pré-processamento da imagem, visto que a imagem resultante do 

processo de aquisição pode conter imperfeições, tais como presença de pixels 

ruidosos, contraste e/ou brilho inadequado, entre outras. A função de uma etapa de 

pré-processamento é aprimorar a qualidade da imagem para análises posteriores. 

Desta afirmação duas importantes implicações devem ser consideradas: 

 

● a interpretação de que um resultado é mais adequado, ou não, 

normalmente é subjetivo e depende do conhecimento prévio do observador a 
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respeito da imagem analisada; 

 

● uma determinada técnica de realce de imagens é orientada a um problema 

que se deseja resolver. Logo, não existem técnicas capazes de resolver 100% dos 

problemas que uma imagem possa apresentar ou mesmo produzir bons resultados 

em imagens diferentes. 

 

As operações efetuadas na etapa de pré-processamento são ditas de baixo 

nível, pois trabalham diretamente com os valores de intensidade de cada pixel, 

levando em conta um prévio conhecimento sobre a imagem em si. Dentre as etapas 

de pré-processamento mais relevantes é a modificação de histogramas. 

 

2.7. Modificação de Histograma de uma Imagem 

O histograma de uma imagem é uma representação gráfica de quantos 

pixels possuem um determinado nível de cinza. Sua interpretação revela a qualidade 

de uma imagem em relação ao contraste e ao brilho. A modificação de um 

histograma modifica a imagem, visto que sua intensidade será modificada, podendo 

realçar detalhes de interesse visto que os níveis de cinza presentes em uma imagem 

podem ser facilmente modificados para realçar a interpretação visual da imagem. 

 

Em uma formulação matemática, supondo que f(x, y) uma imagem com 

valores inteiros e dimensão N x M, com n = 0, 1,..., N – 1 e m = 0, 1,..., M – 1 e os 

níveis de cinza representados por G ={0,1,..., L -1}; o número de pixels com um 

determinado nível de cinza é denotado por nf, então, o histograma de f(x, y) é 

denotado por: 

( )
.

f

f

n
h f

N M
 , para os novéis de cinza indo de G= 0, 1.......L -1  (xy)         [1] 

 

O histograma dá uma rápida impressão da ocupação dos níveis de cinza, 

um exemplo, é a utilização do histograma para verificar os ajustes de captação de 

imagem. Outra característica importante do histograma de uma imagem, é que o 

local representado pelo “pico” do histograma descreve o brilho relativo da imagem, 

enquanto a “altura” deste pico revela detalhes sobre o contraste: em histogramas 
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cuja maioria dos pixels estão mais próximos de zero (ou seja, o pico está próximo 

mais próximo de zero) significa uma imagem mais escura; ao contrário se a maioria 

dos pixels encontram-se mais próximos dos últimos valores do nível de cinza, então 

a imagem é muito mais brilhante; em histogramas onde a maioria dos pixels 

encontram-se em um ponto médio na escala de níveis de cinza, ocupando uma 

pequena região do histograma, significa uma imagem com baixo contraste; pixels 

bem distribuídos ao longo dos níveis de cinza representam imagens com brilho 

normal e alto contraste, conforme pode ser visto na Figura 4 [Apud 32] 

 

   

    

     

Figura 4– Mostra os histogramas correspondentes aos principais tipos de imagens: (a) imagem 

escura; (b) imagem clara; (c) imagem de baixo contraste e (d) imagem de alto contraste. [31] 
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2.8. Processamento de Imagem  

O termo processamento de imagem refere-se a uma função bi-dimensional 

de intensidade de luz, denotada por f(x,y), onde o valor ou amplitude de f em 

coordenadas espaciais dá a intensidade (brilho) da imagem no ponto. Uma imagem 

de um objeto real é, em princípio, contínua tanto na variação espacial quanto nos 

níveis de cinza. Para que a representação de uma imagem possa ser feita num 

computador digital é necessário discretizar a imagem tanto no espaço, quanto na 

amplitude. O processo de discretização espacial em amplitude denomina-se 

quantização [33,34].  

 

As imagens digitalizadas têm propriedades básicas complexas, onde 

imagens bidimensional representadas por f (x,y), sendo x e y as coordenadas 

espaciais e o valor de f em qualquer ponto (x,y) é proporcional ao brilho (ou níveis 

de cinza) da imagem naquele ponto, já as imagens monocromáticas são 

representadas como uma matriz, onde os índices de linhas e de colunas identificam 

um ponto na imagem, conforme Figura 5 (a) e (b).  

 

Cada elemento da matriz chama-se pixel e representa a cor de um ponto da 

imagem, podendo ser, 0 e 1(para uma imagem binária) 0 a 255 (para tons de cinza) 

ou três números de 0 a 255 (representando uma cor distinta). A intensidade de cada 

pixel corresponde à informação local do brilho que será resposta a luz gerada ou 

refletida por ela. O valor correspondente do elemento da matriz identifica o nível de 

intensidade ou de brilho do sinal naquele ponto [35]. Estes elementos da matriz são 

chamados de elementos da imagem ou pixels. Quanto maior o número de pixels de 

uma imagem melhor é a sua resolução.  
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Figura 5-(a) Imagem bidimensional em tons de cinza, e (b) escala em tons de cinza com valores 

atribuídos ao brilho em cada ponto. 

 

2.9. Digitalização 

A quantidade de pixels e suas tonalidades de cinza expressam as 

informações de uma imagem. O número de pixels é expresso em valores das 

dimensões da matriz que forma a imagem como, por exemplo, as dimensões de um 

monitor de vídeo: 640x480, 800x600, 1024x768, etc.  

 

A freqüência de amostragem espacial ou resolução espacial determina o 

número de amostras que é obtido por unidade de comprimento, vertical ou 

horizontal, do sensor (por exemplo, 100 pontos por polegada), e, portanto é um 

parâmetro que determina o número de pontos por linha ou coluna do sensor. Se o 

sensor tiver 1 polegada quadrada, a imagem do exemplo dado teria 100x100 pontos 

(10000 pontos) no total.  

 

A quantidade de tons de cinza é representado em número de bits por pixel, 

b. Conhecendo o valor de b, o número de tons é calculado como 2b. Assim, uma 

imagem com n = 8 bits admite 256 tons de cinza. Quanto maior a quantidade de 

pixels e quanto maior o número tons de cinza, maior o tamanho do arquivo que 

contém a imagem [32] e, portanto, maior o espaço em disco necessário para 
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armazená-la em um computador e maior a quantidade de memória necessária para 

o seu processamento.  

 

Uma imagem monocromática de P pixels tem P(g) pixels para cada nível de 

intensidade g, então, somando P(g) sobre todos os possíveis valores de intensidade, 

g=0,1,2,...,G-1, obtém-se o número total de pixels da imagem, isto é, histograma 

normalizado de intensidade de uma imagem. A presença, na imagem, de objetos 

que exibem grande contraste, ou seja, grande diferença entre os tons de cinza dos 

pixels que formam esses objetos podem ser manifestadas no histograma pela 

presença de picos bem distintos.  

 

O modo como a informação é codificada no arquivo de dados que contém a 

imagem, também conhecido como o formato da imagem, é identificado pela sua 

extensão. Formatos típicos como BMP, TIF, GIF, JPG são utilizados pela ampla 

maioria dos editores e processadores de imagens, ainda que existam algumas 

diferenças, ou sub-formatos, que eventualmente impeçam que uma imagem gravada 

por um programa possa ser lida por outro. Formatos como GIF e JPG têm seus 

arquivos compactados para reduzirem seu tamanho, facilitando a sua armazenagem 

e transmissão.  

 

Existem diferentes regras de compactação, que podem ser classificadas 

conforme haja ou não perda de informação durante a compactação. Assim, por 

exemplo, o formato JPG compacta a imagem com perda de informação, enquanto o 

formato GIF utiliza o algoritmo LZW que compacta a imagem sem perda de 

informação original. Para fins de análise quantitativa de imagens por métodos 

automáticos ou semi-automáticos, deve-se evitar o uso de imagens compactadas 

com perda de informação [34].  

 

2.10. Textura de uma imagem 

A análise de uma imagem pode ser descrita a partir de uma classificação, 

possibilitando o reconhecimento de diferentes parâmetros, os quais destacam as 

regiões de interesse. O processo de classificação dessas imagens é baseado nos 

níveis de cinza ou cores, características de forma e textura. Essas são as 



33 

 

   

características empregadas pelo sistema visual humano, contendo informações 

sobre a distribuição espacial e variação de luminosidade, além de descrever o 

arranjo estrutural das superfícies e relações entre regiões vizinha [36]. 

 

Quando citado a textura de um material ou imagem pode-se ter certeza de 

que é uma das mais importantes características do que esta sendo utilizado para 

classificar e reconhecer objetos e cenas. A definição de textura se faz necessário 

para encontrar uma similaridade entre imagens contidas em um mesmo banco de 

dados. Esta definição não apresenta uma padronização, ocorrendo variações de 

acordo com a utilização do processo e em muitos casos conforme necessidade 

humana. Portanto existe varias definições sobre textura, sendo dependente da área: 

 

 Textura é definida como uma combinação entre magnitude e freqüência 

da variação tonal numa imagem, produzida pelo efeito conjunto de todas as 

pequenas feições que compõem uma área em particular na imagem; [37] 

 

 Textura é uma região da imagem que contem algumas repetições do 

padrão dos níveis de intensidade;[37] 

 

 Textura é definida como sendo a distribuição estatística das propriedades 

da dependência espacial dos níveis de cinza.[38] 

 

2.11. Limiarização 

A Limiarização (thresholding) é definida como um valor mínimo de alguma 

quantidade. É o método de segmentação mais simples que é utilizado mais como 

passo inicial em análise de imagem. Dada uma imagem com coordenadas ƒ(x,y) em 

tons de cinza, a limiarização tem como saída uma imagem binária g(x, y) conforme a 

equação 1:  

g(x,y) = 0 se (x,y) < T  [2] 

g(x,y) = 0 se (x,y) ≥ T  [3] 

 

Onde: 
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T é o limiar (threshold), g(x, y) = 1 para os pontos dos objetos da imagem e 

g(x,y)= 0 para pontos que pertençam ao fundo da imagem. 

 

O T é fundamental para o processo. Entretanto é muito raro uma imagem ser 

segmentada corretamente com apenas um valor para o limiar. Para solucionar este 

problema é possível utilizar a limiarização (threshold) adaptativa (segmentação 

utilizando limiares variáveis), onde o limiar varia em função das características locais 

da imagem (Base de Dados e Imagens). 

 

A limiarização nos permite separar as regiões de uma imagem quando esta 

apresenta duas classes (o fundo e o objeto). A forma mais simples de limiarização 

consiste na bipartição do histograma, convertendo os pixels cujo tom de cinza é 

maior ou igual a certo valor de limiar (T) em brancos e os demais em pretos. 

 

2.12. Métodos de Contagem de Grãos 

Os métodos para contagem manual baseiam-se em três procedimentos 

básicos para a estimação do tamanho de grãos: [30,31]  

 

 Método por comparação: o método de comparação não exige a 

contagem de grãos, interceptos ou intersecções, ao contrário, como o nome sugere 

e, desde que a estrutura de grãos a ser comparada seja equiaxial, é realizada uma 

comparação de estrutura de grãos a uma série de imagens gradeadas na forma 

quadros ou transparências, denominadas cartas. Estas cartas são imagens de 

padrões obtidas por diferentes métodos de ataque à superfície, com tamanhos de 

grãos e aumentos definidos. 

 

 Método planimétrico: o método planimétrico envolve a contagem do 

número de grãos dentro de uma área conhecida. O número de grãos por unidade de 

área é usado para determinar o número grãos por unidade de área.  

 

 Método por contagem de interceptos: o método de contagem de 

interceptos envolve a contagem do número de grãos interceptados por uma linha de 

teste ou o número intersecções entre a linha de teste e os contornos de grãos, por 
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unidade de comprimento da linha de teste. Estas medidas são usadas para calcular 

o comprimento do intercepto linear médio, que por sua vez é usado para determinar 

o número de tamanho de grão ASTM [39].  

 

 Os métodos de análise automática de imagens: são dependentes da 

qualidade do ataque termoquímico realizado para revelar os contornos de grãos, 

assim sendo, a norma ASTM E 1382-97 ressalta a importância e os cuidados que 

devem ser tomados para a revelação da microestrutura da amostra, bem como o 

tratamento da fotomicrografia através do pré-processamento da imagem.[40] Os 

métodos de contagem assemelham-se quanto à metodologia, considerações acerca 

da representatividade da amostra, análise estatística e intervalos de confiança, 

sendo que o método de análise automática permite ao usuário realizar um maior 

número de medições. [30,31] 

 

O processamento digital de imagens atua em imagens e resulta em outras 

imagens e pode ser dividido da seguinte forma: [33] 

 

 Codificação de Imagens (Image Coding): usado para armazenamento e 

“transporte” de imagens;  

 

 Otimização de Imagens (Image Enhancement): usado para facilitar e/ou 

auxiliar a visão humana a perceber determinadas características na imagem; 

 

  Restauração de Imagens (Image Restoration): são as operações 

utilizadas para tentar corrigir distorções advindas dos sistemas de aquisição de 

imagens, tal como borrões e ruído;  

 

 Extração de Características de Imagens (Image Feature Extraction): como 

o nome já propõe, trata-se das técnicas que transformam uma dada imagem em 

outra, na qual medições podem ser extraídas com maior facilidade.  

 

O item que trata de extração de informações da imagem é conhecido 

também como Análise de Imagens (Image Analysis). Antes de realizar a análise 
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quantitativa de imagens, ou seja, extrair informações de forma a inferir 

quantitativamente nos elementos presentes na imagem, é necessário uma etapa de 

pré-processamento para remover defeitos presentes e realçar as características 

desejadas, que podem ser resultantes da aquisição da imagem e tratam-se desde 

pixels ruidosos a borrões. Dentre as operações mais comuns na etapa de pré-

processamento podemos destacar a equalização de histograma e filtragens [41]. 

  

2.13. A Análise Automática de Imagens  

A análise automática de imagens é feita por softwares próprios para análise 

de imagens. A partir da análise automática de imagens um vasto número de grãos 

pode ser analisado na imagem obtida por microscopia e possibilita também a 

orientação dos resultados sob a forma de histogramas de frequência (número de 

ocorrências X classes limites). Um fator importante está na representatividade da 

amostra, ou seja, o número de amostras e campos de observação deve ser 

suficiente para que a análise seja representativa. 

  

Para análise de imagens com o uso de softwares, a precisão dos resultados 

depende da representatividade e da preparação das amostras, visto que tais 

características influenciam na revelação dos grãos, deve-se também observar à 

realização de etapas de pré-processamento, tal como filtragens, para que sua 

intervenção não influencie tendenciosamente nas análises realizadas. Apesar das 

facilidades em poder realçar características de interesse através de softwares, como 

por exemplo, completar contornos de grãos quando estes não estão completamente 

revelados, tais procedimentos devem ser utilizados com cautela.  

 

Sendo o ImageJ um software de código aberto, feito em Java e extensível 

através de plugins, de auxílio ao processamento e análise de imagens é possível 

através dele criar várias funções de processamento e análise de imagens.[42]  

 

Para que seja realizada a análise quantitativa de uma imagem, é necessário 

o pré-processamento da imagem, pois imagens resultantes de processos de 

aquisição podem conter imperfeições, tais como pixels ruidosos, contraste e/ou 

brilho inadequado, entre outras imperfeições, tendo a função de aprimorar a 
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qualidade da imagem para análises posteriores. Desta afirmação decorrem duas 

importantes implicações:  

 

• A interpretação de que um resultado é mais adequado, ou não, 

normalmente é subjetivo e depende do conhecimento prévio do observador a 

respeito da imagem analisada;  

 

• Uma determinada técnica de realce de imagens é orientada a um 

problema que se deseja resolver. Logo, não existem técnicas capazes de resolver 

100% dos problemas que uma imagem possa apresentar ou mesmo produzir bons 

resultados em imagens diferentes.  

 

As operações de pré-processamento são ditas de baixo nível, pois trabalham 

diretamente com os valores de intensidade de cada pixel, levando em conta um 

prévio conhecimento sobre a imagem em si. Dentre as etapas de pré-

processamento mais relevantes podemos destacar a modificação de histograma e a 

filtragem. 

 

2.14. Software ImageJ (NIH Image J) 

O NIH ImageJ é um programa de processamento de imagem de domínio 

público e distribuição gratuita, inspirado pelo NIH Image para Macintosh, 

desenvolvido pelo National Institute of Health, em Bethesda, liberado por Wayne 

Rasband. Ele roda como um applet8 ou como um aplicativo em qualquer 

computador que possua Java 1.1 . É suportado em Windows, Mac OS, Mac OS X e 

Linux. Pode ler imagens TIFF, GIF, JPEG, BMP, DICOM, FITS e "RAW". Suporta 

pilhas ou series de imagens a serem processadas. É multithreaded, isto é, pode 

efetuar diferentes funções ao mesmo tempo, a leitura de uma pode ser executada 

em paralelo com outras operações, conforme é mostrado na Figura 8, o ambiente de 

trabalho do ImageJ[43]. 
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Figura 6 - Ambiente de trabalho ImageJ 

 

2.15. Análise de Tamanhos de Grãos por Diâmetro de Feret  

Diâmetro de Feret é uma medida que ganhou importância na análise de 

partículas durante os últimos… 80 anos, pelo menos. É uma forma de caracterizar 

tamanho, que não depende da posição do objeto na imagem. Apesar da definição 

aparentemente simples, a evolução do conceito criou um conjunto de medidas. Feret 

Máximo e Feret Mínimo passaram a ser usados amplamente como medidas que 

descrevem comprimento e largura de partículas.[43] Essa metodologia da análise de 

tamanho de grãos utilizada no software ImageJ apresenta limitações devido à 

execução de tamanhos de grãos de maneira individual. 

 

    
Figura 7 - (a) projeção planar do grão; (b)projeção das retas tangenciadas sobre a imagem planar de 

um grão 

 

As variáveis FeretX e FeretY são as coordenadas do primeiro ponto da linha 

que representa do Feret Máximo (que no ImageJ é chamado simplesmente de 

Feret), conforme figura 7(a). Conforme Walton, 1948 , essa metodologia foi 

desenvolvida mais para desenhar a linha do que qualquer outras aplicações.[44] 

 

O FeretAngle é o ângulo formado entre o plano horizontal e a linha do Feret 



39 

 

   

Máximo, no sentido anti-horário. E o Feret Mínimo é a medida perpendicular ao 

Feret Máximo, que inclui toda a partícula. É como se desenhássemos duas linhas 

paralelas ao Ferret máximo, uma de cada lado, tangenciando a partícula, e 

medíssemos a distância entre elas. Para esta análise as imagens devem estar 

binarizadas facilitando a indicação a distância entre duas retas paralelas que 

tangenciam o objeto, excluindo os grãos dispostos na borda da imagem [45]. As 

Figuras 7 (a) e 7 (b) mostram como um grão é considerado na análise através do 

método de Feret. 
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CAPITULO 3 

 

MATERIAIS E MÉTODOS  

A metodologia utilizada nesse trabalho busca a ampliação do conhecimento 

e melhoria nos resultados de análise de imagem. Para isso o software livre ImageJ 

foi utilizado para analisar as imagens e delimitar as regiões de interesse da 

microestrutura das cerâmicas de zircônia [28]. O aprimoramento em análise de 

imagens de cerâmicas a base de zirconia, se faz necessário para o entendimento e 

utilização de suas particularidades. As imagens automatizadas geram uma maior 

aproximação da microestrutura dos materiais com suas propriedades com grande 

rapidez e precisão sem interferência do operador. Entretanto todos as micrografias 

analisadas nesse trabalho foram desenvolvidos pela empresa ProtMat Materiais 

Avançados, e faz parte da dissertação de mestrado da aluna Caroline Hartung 

Habibe, defendida em 24/09/2011[45].  

  

3.1. Materiais 

Nesse trabalho corpos de prova cerâmicos a base de zircônia estabilizada 

com itria, foram desenvolvidos pela empresa ProtMat Materiais Avançados que atua 

no ramo de desenvolvimento de cerâmicas e metais para aplicações como próteses 

dentarias. Os corpos de prova foram confeccionados por de prensagem uniaxial 

(80MPa-30s), sinterizados na temperatura de 1450 0C, 1500 0C, 1530 0C e 1600 

0C, com patamar de 120min (2h) e 240min (4h) com taxa de aquecimento foi de 10 

°C/min até a temperatura final pré-estabelecida. A taxa de resfriamento foi de 5 

°C/min até a temperatura ambiente, visando minimizar os possíveis efeitos do 

resfriamento nas propriedades do material [46]. 

 

3.2. Propriedades das Cerâmicas a Base de Zirconia 

As cerâmicas utilizadas nesse trabalho foram caracterizadas quanto a 

densidade relativa pelo Método de Arquimedes, dureza e tenacidade a fraturas 

foram avaliadas utilizando método de indentação Vickers, baseando-se nas normas 

ASTM-C-1327-99 [47] e ASTM-C-1421-99 [48]. Os resultados de propriedades das 
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cerâmicas utilizadas nesse trabalho mostram que as mesmas variam em função da 

temperatura e tempo de sinterização. Esses resultados estão relacionados com os 

tamanhos de grãos das microestruturas das cerâmicas, mostrados na Figura 8. 

Esses resultados são importantes para uma possível correlação com análise 

realizados pelo software ImageJ.  A Tabela 1 mostra as propriedades das cerâmicas 

utilizadas nesse trabalho. 

 

Tabela 2 - mostra as propriedades física e mecânica das amostras 

Propriedades/h 1450 ºC 1500 ºC 1530 ºC 1600 ºC 

Densidade % /2h  91,6 95,3 98,7 99,8 

Densidade % /4h 92,5 97 99,1 99,8 

HV (GPa)/2h 1029 1148 1255 1273 

HV (GPa)/4h 1051 1180 1266 1275 

Kic MPa.m1/2/2h 3,15 4,5 5,95 5,55 

Kic MPa.m1/2/4h 3,3 4,6 5,65 5,28 

  

3.3. Análise das Microestruturas por MEV 

Para análise das microestruturas, as cerâmicas foram submetidas a 

preparação ceramografica com polimento  final automático utilizando suspensões de 

diamante com granulometrias de 3 e 1 µm respectivamente. Para obtenção das 

micrografias as cerâmicas foram submetidas ao ataque térmico a 1400 ºC com 

patamar de 15 minutos, a taxa de aquecimento foi de 20 ºC/min e resfriamento 10 

ºC/min. e submetidas à análise por microscopia eletrônica de varredura sendo as 

imagens capturadas em diferentes regiões das amostras com diferentes ampliações, 

conforme Figuras 8 (a) à 8 (f).  

 

As Figuras 8 (a) à 8 (f) mostram as microestruturas das cerâmicas que serão 

analisadas. 
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Figura 8 -  amostras sinterizadas as temperaturas de (a) 1450 °C – 4h, (b) 1500 °C – 2h, (c) 1530 °C 
– 4h, (d) 1530 °C – 2h, (e) 1600 °C – 4h e (f) 1450 °C – 2h 

(f) 1450 °C – 

2h 

(d) 1530 °C – 

2h 

(c) 1530 °C – 

4h 

(b) 1500 °C – 

2h 

(a) 1450 °C – 

4h 
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CAPITULO 4 

 

RESULTADOS  

Esse trabalho mostra os avanços alcançados em análises de 

microestruturas de materiais cerâmicos a base de zirconia com o uso do software 

livre ImageJ. Foram desenvolvidos e aplicados, rotinas e técnicas para análise das 

microestruturas, implementações de plugins para melhorias de obtenção de 

resultados, conforme anexo. Os resultados obtidos foram em função da contagem, 

perímetros e áreas dos grãos, com os resultados demonstrados em planilhas e 

gráficos. Os resultados mostram uma correlação entre, os tamanhos e quantidades 

de grãos, em função das propriedades mecânicas das cerâmicas mostrada na 

Tabela 1. Entretanto os resultados onde aplicou-se os novos plugins serão 

demonstrados passo a passo sua aplicação, sendo os maiores detalhes expostos 

em anexos.  

 

4.1 Implementações de Plugins 

Nesse trabalho foram implementados novos plugins dentro dos códigos fonte 

para melhoria da eficiência e confiabilidade das caracterizações microestruturais. 

 

Para fácil compreensão utilizou-se reticências (...) para indicar a existência 

de plugins dentro dos códigos fonte, sendo os mesmos dispondo em negritos.  

 

4.1.1 Circularidade (Circularity) 

A circularidade (Circularity) é uma característica que pode ser usada para 

filtrar os grãos de interesse. Os valores variam de 0 (zero) a 1.0 (um) sendo 1.0 o 

valor de um círculo perfeito.  

 

O código para definição de circularidade foi desenvolvido a partir de 

bibliotecas já existentes no ImageJ. 

 

O plugin chamado de circularidade (Circularity_.java) é um complemento de 
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comandos do ImageJ, que calcula circularidade do objeto usando a fórmula = 

circularidade 4pi (área / perímetro ^ 2). 

import ij.*;  

import ij.plugin.filter.*;  
import ij.process.*;  
import ij.gui.*;  
import ij.measure.*; 
public class Circularity_ implements PlugInFilter, Measurements  
{  ImagePlus imp;  

public int setup(String arg, ImagePlus imp)  
{  if (IJ.versionLessThan("1.18o"))  

return DONE;  
this.imp = imp;  
return DOES_ALL;  

}  
public void run(ImageProcessor ip)  
{        int measurements = Analyzer.getMeasurements();  

measurements |= AREA+PERIMETER;  
Analyzer.setMeasurements(measurements);  
Analyzer a = new Analyzer();  
ImageStatistics stats = imp.getStatistics(measurements);  
Roi roi = imp.getRoi();  
a.saveResults(stats, roi);  
ResultsTable rt =Analyzer.getResultsTable();  
int counter = rt.getCounter();  
double area = rt.getValue(ResultsTable.AREA, counter-1);  
double perimeter = rt.getValue(ResultsTable.PERIMETER, counter-1);  
rt.addValue("Circularity", 

perimeter==0.0?0.0:4.0*Math.PI*(area/(perimeter*perimeter)));  
a.displayResults();  
a.updateHeadings();  

}  
} 
 

4.1.2 – Barra de Escala (ScaleBar.java) 

Os plugins implementados para conversão das barras de escala tem como 

finalidade facilitar os usuários futuros do ImageJ com transformação da escala 

obtida no microscópio para escala em milímetro.  Essas implementações promove a 

transformação das barras de micrometro e nanometrico para milímetros mostrando 

as dimensões dos grãos em milímetros. 

 

... 
public class ScaleBar implements PlugIn { 
… 
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void drawScaleBar(ImagePlus imp) { 
          if (!updateLocation()) 
            return; 
        Undo.setup(Undo.FILTER, imp); 
        drawScaleBar(imp.getProcessor(), getUnits(imp)); 
        imp.updateAndDraw(); 
    } 

... 

ip.resetRoi(); 
ip.setColor(color); 
ip.setRoi(x, y, barWidthInPixels, barHeightInPixels); 
ip.fill(); 
ip.resetRoi(); 
if (!hideText) 
            ip.drawString(label, x+xoffset, y+yoffset); 

… 

}//fim do arquivo 

 

4.1.3 – Área dos Grãos (Feret) 

O diâmetro Feret é conhecido como o comprimento paquímetro. O macro 

Diâmetro do Feret é a distância mais longa entre dois pontos quaisquer ao longo da 

função “fronteira ROI” do software livre ImageJ sendo uma opção inserida em 

measurment ImageJ. 

 

Para analise dos diâmetros dos grãos foram implementados vários plugins 

para melhoria e facilidade desses recursos no software livre ImageJ.  

 

No aplicativo do software existe o aplicativo Feret, entretanto esse aplicativo 

tem como finalidade executar mediadas dos diâmetros e/ou áreas de forma unitária, 

não sendo executado a soma total dos mesmos. Assim essa implementação fornece 

ao usuário tamanho de grãos e distribuição acumulada em forme de gráficos. 

 

drawFeretsDiameter(); 
 
macro "Draw Ferets Diameter" { 
    drawFeretsDiameter(); 
} 
 
macro "Analyze Particles and Draw" { 
    run("Analyze Particles...", "show=Nothing exclude clear record"); 
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    drawAllFeretsDiameters(); 
} 
 
function drawAllFeretsDiameters() { 
    for (i=0; i<nResults; i++) { 
        x = getResult('XStart', i); 
        y = getResult('YStart', i); 
        doWand(x,y); 
        drawFeretsDiameter(); 
        if (i%5==0) showProgress(i/nResults); 
   } 
    run("Select None"); 
} 
 
function drawFeretsDiameter() { 
     requires("1.29n"); 
     run("Line Width...", "line=1"); 
     diameter = 0.0; 
     getSelectionCoordinates(xCoordinates, yCoordinates); 
     n = xCoordinates.length; 
     for (i=0; i<n; i++) { 
        for (j=i; j<n; j++) { 
            dx = xCoordinates[i] - xCoordinates[j]; 
            dy = yCoordinates[i] - yCoordinates[j]; 
            d = sqrt(dx*dx + dy*dy); 
            if (d>diameter) { 
                diameter = d; 
                i1 = i; 
                i2 = j; 
            } 
        } 
    } 
    setForegroundColor(255,127,255); 
    drawLine(xCoordinates[i1], yCoordinates[i1],xCoordinates[i2],yCoordinates[i2]); 
} 

 

4.1.4- Analise da Implementação dos Plugins no Software Livre ImageJ 

O desenvolvimento de novos plugins nos comandos do software ImageJ 

aprimorou e melhorou a execução das interfaces. Dentro desse contesto podemos 

assegurar uma geração de resultados confiáveis e de execução dinâmica podendo 

ser utilizados com eficiência pelos operadores. Entretanto outras modificações foram 

realizadas e devido a sua menor significância estão inseridas em anexos. 
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4.2. Análise da Qualidade das Imagens Através de Histogramas  

Esse item mostra as respectivas microestruturas obtidas por MEV das 

cerâmicas à base de zircônia, e seus histogramas conforme Figuras 9 (a) à 9 (f). O 

histograma de uma imagem tem como finalidade representar a identidade gráfica de 

quantos pixels possui um determinado nível de cinza, e essa interpretação revela a 

qualidade de uma imagem em relação ao contraste e ao brilho. As imagens 

utilizadas são reproduzidas do item 3.3 sendo acrescidos o histograma, com a 

finalidade de mostrar a qualidade das imagens de partida e seus respectivos 

tratamento com aplicação do software livre ImageJ. Nas Figuras 9 (a) à 9 (f) 

podemos observar as imagens original e seus histogramas denominados de 9 (a`) à 

9 (f`). 

 

         
Figuras 9(a) e 9(a’) podemos observar a imagem original e seu histograma. 
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Figuras 9(b) e 9(b’) podemos observar a imagem original e seu histograma. 

 

      
Figuras 9(c) e 9(c’) podemos observar a imagem original e seu histograma. 
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Figuras 9(d) e 9(d’) podemos observar a imagem original e seu histograma. 

 

      
Figuras 9(e) e 9(e’) podemos observar a imagem original e seu histograma. 
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Figura 9 (f) e 9(f’) podemos observar a imagem original e seu histograma. 

 

Analisando as Figuras 9 (a) à 9 (f) com seus respectivos histogramas 

podemos observar que o tempo e a temperatura influenciaram no tamanho dos 

grãos, propriedades e resolução das imagens das cerâmicas. Nessas Figuras 

(amostras) podemos concluir que a olho nu é possível fazer uma análise 

macroscópica dessas microestruturas, mas não é possível determinar de maneira 

precisa uma microestrutura que ofereça as propriedades desejadas, para uma 

determinada aplicação.  

 

Essas micrografias obtidas por MEV apresentam regiões mais escuras, 

como fases intergranular, cinza clara como grãos de zircônia e em algumas imagens 

gotículas (pontos) clara que pode ser defeitos na preparação e/ou aquisição das 

imagens. Todas as imagens apresentam ruídos, com maior ou menor intensidade, 

isto é, pixels apresentando intensidade de brilho diferente dos pixels vizinhos, além 

de possuir baixo contraste, isto é, as cores dos grãos e fases intergranulares são 

diferentes, mas com intensidades próximas, dificultando a distinção entre elas.  

 

Analisando os histogramas das imagens foi possível observar que as 

micrografias apresentam grandes diferenças de resolução. As figuras 9 (a’) à 9 (f’), 

mostram que as imagens de partidas possui três camadas de cores (RGB stack), em 

destaque na Figura 9(a’), ou seja vermelho, verde e azul. Fica evidente que o uso de 

histograma em análise de imagem é uma ferramenta imprescindível para representar 
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e definir a sua qualidade.  

 

A resolução de uma imagem é definida em função da intensidade dos picos 

e largura da base, sendo a imagem com a melhor resolução, nesse trabalho, pode 

ser atribuída a Figura 9(c’) que possui menor variação de tonalidades dos pixels 

para cores claras, apresentando valor médio do pixel de 94,226, enquanto que a 

Figura 9(f’) possui maior variação de tonalidades dos pixels para cores claras, 

apresentando valor médio do pixel de 121,668. Portanto a análise visual pode 

concluir superficialmente algumas informações das amostras.   

 

4.3. Pré-Tratamento das Imagens Utilizando Software de Edição de Imagem 

A utilização de software específico para análise de imagem é de grande 

importância, pois as informações obtidas da imagem de partida não são suficientes 

para aplicação direta do software livre ImageJ, devido a proximidade dos valores de 

pixels.  

 

Nesse trabalho primeiramente foi utilizado o software de tratamento de 

imagem Microsoft Paint para realce dos contornos de grãos, conforme Figuras 10 (a) 

à 10 (f). Na segunda etapa foi utilizado a ferramenta RGBStack do ImageJ 

separando a imagem em três camadas de cores. Para visão humana não é possível 

identificar as diferenças entre as camadas de corres, mas para a visão 

computacional foram separadas em três camadas, identificadas na barra de status 

da amostra em destaque nas Figuras 10 (a`) à 10 (f`). 
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Figuras 10(a) e 10(a’) - imagem da amostra 1450 °C – 4H com contorno delineado e seu histograma. 

 

 

Figuras 10(b) e 10(b’)  - imagem da amostra 1500 °C – 2H  com contorno delineado e seu 

histograma. 
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Figuras 10(c) e 10(c’) – imagem da amostra 1530 °C – 4H  com contorno delineado e seu histograma. 

 

 

Figuras 10(d) e 10(d’)  - imagem da amostra 1530 °C – 2H  com contorno delineado e seu 

histograma. 
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Figuras 10(e) e 10(e’)  -  imagem da amostra 1600 °C – 4H com contorno delineado e seu 

histograma. 

 

 

Figura 10(f) e (f') – imagem da amostra 1450 °C – 2h com contorno delineado e seu histograma. 

Figura 10 (a) à (f) e (a’) à (f’) - imagens de amostras com contorno delineado e seu histograma. 
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Com a utilização do software Microsoft Paint para realce do contorno de 

grãos e a exclusão de duas das camadas de cores RGB foi possível identificar nos 

respectivos histogramas das Figuras 10(a`) a 10(f’) as diferenças e separações de 

dos valores de pixel permitindo a individualização dos grãos, além de reduzir as 

etapas do processamento das imagens. 

 

Na primeira etapa da análise das micrografias foi utilizado o software 

Microsoft Paint para realce dos contornos de grãos. Em seguida o que se deu 

através da aplicação do recurso RGB-Stacks foi a acentuação da diferença de cores 

entre as duas fases. Este recurso suaviza a imagem tomando o valor médio dos 

pixels vizinhos, incluindo somente os que contêm um valor que não desvie do valor 

do pixel de referência, eliminando assim os ruídos da imagem, preservando 

interfaces. A exclusão das camadas verde e azul do sistema RGB contribui para 

redução de ruídos podendo aplicar o recurso thresholding realizando a normalização 

da imagem.  

 

A normalização do contraste consiste em utilizar toda a faixa de valores 

possíveis para os pixels da imagem, por exemplo, em imagens de 8 bits os pixels 

mais escuros receberão valor 0 e os mais claros 255, enquanto o restante recebe 

valores intermediários. As Figuras 9(a) a 9(f) mostram as imagens e seus histograma 

de cores não normalizado. Comparando com as Figuras 10(a) à 10(f) podemos 

observar que os ruídos foram reduzidos. Essas Figuras apresentam um histograma 

normalizado contendo duas regiões distintas: uma região branca representando as 

fases intergranular, cinza como grãos de zircônia. 

 

4.4. Aplicando Filtro Thresholding nas Imagens das Cerâmicas 

Utilizando a ferramenta “Threshold” (Limiarização), promoveu a 

transformação para valor 0 os mais escuros e 255 o valor dos pixels mais claros. 

Nessa etapa definiu-se a região de referência a ser analisada, dentro de uma faixa 

definida pelo usuário, eliminando assim os ruídos da imagem, preservando 

interfaces. As Figuras 11(a) a 11(f) mostram as imagens da microestrutura tratada 

com o filtro thresholding.  
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Figura 11 (a) à 11(f) - mostram as imagens da microestrutura tratada com o filtro thresholding 
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A utilização do filtro thresholding promove uma inteira distinção geometrica 

dos grãos e seus contornos.  

  

4.5. Transformação das Escalas 

Nesse item será demonstrado o processo de transformação de escalas 

utilizando os plugins implementados (item 4.1.2). A aplicação das transformações de 

escalas permite a conversão das escalas de pixels para milímetros. 

 

Nas microestruturas obtidas por MEV aplicou-se a conversão de escalas 

através do comando Analyze -> Set Scale.  Para isso utilizou-se a Figura 8 (a) do 

item 3.3 que nesse procedimento serão denominadas de Figura 12(a) e (b). 

 

A aplicação da transformação de escala compreende referenciar a medida 

da barra de escala, ha uma determinada quantidade de pixels, convertendo para 

escala padrão do programa que com o auxilio dos plugins implementados 

transformam a quantidade de pixels em milímetros.  Para isso constrói-se uma reta 

(escala sobre-escrita) sobre a barra de escala original referente ao número de pixels 

existentes no traçado reto feito, então é digitado no segundo campo Pixel aspect 

ratio (Proporção de pixel) o valor da barra de escala original e no quarto campo Unit 

of length (Unidade de comprimento) é escrita a unidade de medida a ser utilizada 

Figura 13 (b).  

 

Essa permite uma perfeita calibração com os deferentes tamanhos de 

escalas obtidas no MEV. 
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Figura 12 - (a) imagem da amostra com barra de escala selecionada (b) seletor utilizado na barra de 

escala. 

 

 
Figura 12 (b)– Modelo de transformação de escalas 

 

A eficiência da transformação de escalas permite uma real comparação das 

áreas e dimensões dos grãos sendo diretamente relacionada com as propriedades 

dos materiais analisados. 
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4.6. Quantificação e Qualificação dos Grãos 

As analise da microestrutura em função da quantificação e qualificação dos 

grãos tem como objetivo determinar a quantidade e dimensões dos grãos. Para isso 

utilizou-se os incrementos realizados no item 4.5.  Para essas analises foi utilizadas 

a Figura 11 (d) após filtro thresholding (binarizada) como modelo representativos. 

 

 
Figura 13  - Modelo de aplicação de comando de análise de partículas 

 

Utilizando as imagens binarizadas das Figuras 11(a) à 11(f), e com auxilio 

dos novos plugins implementados obteve-se a identificação individual dos grãos e 

suas respectivas áreas, que serão representadas como Figuras 14(a) à 14(f). 

 

Aplicando a metodologia descrita acima podemos observar os grãos de 

formas individuais e suas respectivas planilhas, onde podemos observar uma 

microestrutura de materiais definidas por números, e seus respectivos valores de 

área, perímetro e diâmetro. Essa analise pode ser realizada seguindo uma rotina de 

caixa de diálogo (menu) existente no software livre ImageJ, como por exemplo: 

 

 Display results: tem como função deixar marcado, se você espera ver os 

resultados obtidos para cada objeto.  



60 

 

   

 Clear results: apaga resultados anteriores e mostra apenas o da análise 

corrente. 

 

 Summarize: mostra o resumo da análise, como número total de 

partículas, área total, etc.  

 

 Exclude on Edges: deixa de contar quaisquer partículas que toquem o 

limite da figura.  

 

 Include Holes: inclui os buracos como parte da partícula. Além de incluir 

os buracos na medição da área, também faz com que partículas dentro de outras 

partículas não sejam contadas.  

 

 Record Starts: permite que macros e plugins recriem representações das 

partículas para quaisquer que sejam seus propósitos.  

 

 Add to Mananger: inclui as partículas medidas no ROI Manager, que é 

uma forma de trabalhar com várias regiões de interesse, independente da sua 

localização.  

 

Os resultados obtidos nas Figuras 14(a) à 14(f) que foram executados 

utilizando as seguintes caixas de diálogos: Display results, Summarize, Exclude on 

Edges e Include Holes. 
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Figura 14 – (a) à (f) imagens com contorno segmentado e grãos identificados numericamente (a’) à 

(f’) – planilha com valores das frações volumétricas 

 

Os resultados obtidos de quantificação e qualificação dos grãos nas Figuras 

acima mostram que as implementações realizadas no programa software livre 

ImageJ são importantes e eficientes na obtenção numérica de uma microestrutura 

de um material. De acordo com os resultados obtidos podemos observar 

microestruturas com grãos heterogêneos em função da temperatura e tempo de 

sinterização utilizado. De uma maneira geral podemos relacionar os resultados 
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obtidos com as propriedades mecânicas das cerâmicas de zircônia em função dos 

grãos de zircônia. Para fácil compreensão os resultados foram demonstrados em 

gráficos de barras mostrando a distribuição acumulada de tamanho de grãos. Os 

gráficos de barras são mostrados nas Figuras 15 (a) à 15 (f). 
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Figura 15 (a) à (f) – gráficos de distribuição de tamanho de grão 

 

Os gráficos de barras representam a distribuição acumulativa dos grãos 

sendo possível determinar de forma rápida qual é a maior concentração de 

tamanhos de grãos em uma determinada microestrutura. Através desse gráfico 

podem-se determinar os parâmetros de sinterização a ser utilizado para obter 

determinadas propriedades.  
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CONCLUSÃO 

A criação das interfaces, desenvolvimentos de rotinas e técnicas tornou o 

uso do software livre ImageJ mais amigável, com possibilidade de uso por diversos 

profissionais e segmentos. 

 

A utilização de análise de imagem automatizada gera resultados com grande 

rapidez e precisão, sem interferência do operador. 

 

A metodologia proposta permitiu importantes avanços na aplicação do 

software livre ImageJ em análise de microestruturas equaxial de materiais. 

 

As implementações de interfaces realizadas permitiu quantificar e qualificar 

uma microestrutura de um determinado material de maneira dinâmica, e 

correlacionar com suas propriedades físicas e mecânicas. 

 

Utilizando a metodologia proposta nesse trabalho pode-se obter importantes 

resultados de análises de microestruturas de cerâmicas à base de zircônia com 

relação direta com as propriedades físicas e mecânicas.  
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APÊNDICE 1 

 

MANUAL DE APLICAÇÃO DO SOFTWARE LIVRE IMAGE J 

As imagens utilizadas nesse trabalho sofreram etapas de processamentos 

que resultaram em importantes resultados.  

 

Deve-se salientar que os procedimentos aqui apresentados podem ser 

utilizados nas analises de microestruturas com grãos equaxiais. Para esse efeito 

aqui fica disponibilizado o manual de execução das analises, tendo como maior 

referência a dissertação aqui apresentada. 

 

Passo 1: Abrir imagem da amostra obtida do MEV, figura 16 (a), com 

contorno realçado clicando no menu File -> Open, conforme Figura 16 (b) 
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Figura 16:(a)Imagem da amostra original obtida do MEV; (b) Amostra com contorno de grão realçado 

através do editor de imagem Paint. 

 

2º Passo: Após aberta a imagem da amostra, utiliza-se o menu Image -> 

Type -> RGB Color para conversão do formato, que inicialmente a amostra teria 8-bit 

Color Figura 17 (a), para coloração Red-Green-Blue (RGB Color )  e em seguida 

separando estes canais de cores em camadas (RGB stack) através do menu Image -

> Type -> RGB Stack  Figura 17 (b) 
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Figura 17: (a) acesso ao menu de comando de conversão para RGB Color; (b) comando RGB Stack 

 

Observe na Figura 18 que para visão humana não houve mudança na 

amostra, mas para a visão computacional foram separadas em três camadas, 

identificadas na barra de status da amostra destaque na Figura 18. 
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Figura 18: Amostra com as camadas de cores separadas 

 

Para que a amostra possa ser binarizada é necessário excluir duas das três 

camadas de cores, para esta etapa do tratamento da amostra utilizando o comando 

Image -> Stacks -> Delete Slice visto na Figura 19. 
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Figura 19: acesso ao menu de comando Image -> Stacks -> Delete Slice  que exclui a camada de cor. 

 

O próximo passo, que só é utilizado, no caso de não obter sucesso no uso 

direto do comando de binarização (Threshold), é a inversão de cores da amostra 

para que o contorno do grão fique ainda mais realçado, conforme a Figura 20, para 

isto utiliza-se o comando Edit -> Invert.  
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Figura 20: Amostra com recurso de inversão de cores para realce do contorno do grão 

 

Com ou sem a inversão das cores feitas e assim o contorno de grão 

realçado, é feito o ajuste da amostra com a binarização, utilizando o comando Image 

-> Adjuste -> Threshold , conforme Figura  21. 
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Figura 21: acesso ao comando de binarização 

 

Feita a binarização Figura 22 (a) ainda existem alguns ruídos na amostra 

que são os pontos brancos irregulares existentes nesta amostra, mas com a barra 

de ferramenta de controle de intensidade das cores preta e branca pode-se corrigir 

estes ruídos deslizando o seletor pela barra indicada na Figura 22 (b).  
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Figura 22: (a) Amostra binarizada e ainda com ruídos e (b) ferramenta de variação de intensidade da 

cor. 

 

O resultado deste tratamento da amostra é a correção dos pontos brancos 

irregulares deixando-a sem ruídos, conforme Figura 23. 

 

 
Figura 23: Amostra binarizada e corrigida pela intensidade de cor. 
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Dando continuidade a análise da amostra, passaremos à etapa de análise 

de partículas. Como existem diferentes escalas de medida de amostras obtidas por 

MEV é necessário criar a escala equivalente para esta amostra. Abrindo a amostra 

original Figura 16 (a) e utilizando o comando Analyze -> Set Scale. Observando que 

na parte inferior da amostra, em destaque na Figura 24 (a), aparece a barra de 

escala que será utilizada como referência para que o programa possa relacionar 

esta medida à quantidade de pixel. 

 

Após utilizado o comando, aparecerá a caixa de diálogo, como a da Figura 

24 (b) que utiliza-se para referenciar a medida da barra de escala à uma 

determinada quantidade de pixels. 
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Figura 24: (a) Amostra Original com barra de escala e menu de acesso ao comando de criação de 

escala; (b) Caixa de diálogo onde é criada a escala 

 

Clicando no botão ao centro da caixa de diálogo, Click to Remove Scale na 

Figura 24 (b), será apagada a escala padrão do programa ou a utilizada 

anteriormente, para que permita a criação de uma escala compatível com a amostra 

em uso. 

 

Em seguida é selecionada a ferramenta de traço reto existente na caixa de 

ferramentas do programa ImageJ, em destaque na parte superior da Figura 25 e 

com o auxílio do mouse é traçada uma reta sobre a barra de escala, conforme o 

destaque na  parte inferior da Figura  25. 
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Figura 25: Ferramenta de traçado reto para criação da escala para a amostra 

 

Feito o procedimento de traço sobre a barra de escala é criada uma nova 

referente à amostra em uso, através do comando Analyse -> Set Scale (Analisar -> 

Definir Escala), exibindo a caixa de diálogo para criação da mencionada escala, 

conforme a Figura 26.  

 

O primeiro campo Distance in pixels (Distância em pixels), que para esta 

amostra, apresenta o valor 145 referente ao número de pixels existentes no traçado 

reto feito sobre a barra de escala, então é digitado no segundo campo Pixel aspect 

ratio (Proporção de pixel) o valor da barra de escala original e no quarto campo Unit 

of length (Unidade de comprimento) é escrita a unidade de medida a ser utilizada e 

como utilizaremos esta escala criada para a medição da amostra anteriormente 

binarizada é necessário marcar a opção Global e para concluir esta etapa clicar no 

botão OK. 

 

 
Figura 26: Caixa de diálogo preenchida com os valores de medida para a amostra em uso. 

Inserir o valor referente ao 

obtido pelo MEV. 
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Selecionando novamente a janela que contém a amostra binarizada e 

através do comando Analyze -> SetMeasurements (Analisar -> Medidas conjunto), 

conforme a figura 27 (a), será aberta uma outra caixa de diálogo, Figura 27 (b), onde 

seleciona-se quais as informações da amostra quer que seja exibida ao final da 

análise. Neste caso, as opções que aparecem selecionadas na Figura 27 (b) exibem 

o resultado da medida da área, do perímetro e do diâmetro dos grãos.  
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Figura 27: (a) acesso ao comando onde são selecionadas as opções de resultado; (b) caixa de 

diálogo de resultados a serem mostrados 

 
Após feita a escala de medida adequada a esta amostra é selecionando o 

comando Analyze -> Analyse Particles (Analisar -> Analisar Partículas) , conforme a 

Figura 28(a), exibindo então outra caixa de diálogo visível na figura 28 (b), onde é 

selecionada a opção Outlines (contornos), no campo Show, para que o resultado a 

ser calculado tenha como orientação a linha de contorno do grão e para que não 

haja conflito de informação devido a borda da janela marca-se a opção Exclude on 

edges (Excluir nas bordas), que despreza os grão que estão em contato com a 

borda da janela. 
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Figura 28: (a) acesso ao comando onde é acessada a ferramenta que contém as opções de 

resultado; (b) caixa de diálogo de resultados a serem mostrados 
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Clicando no botão OK são geradas as janelas com a planilha de resultados, 

conforme Figura 29(a) valores de área, perímetro e diâmetro (Ferret) e Figura 29 (b) 

identificação indexada numérica dos Grãos. 
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Figura 29: (a) Planilha de resultados (b) grãos com contorno realçados e indexados 

 

Para exibir um gráfico com a distribuição dos grãos basta clicar no menu 

Result -> Distribuition, conforme Figura 30, e será exibida uma caixa de diálogo 

como visto na Figura 31, onde poderá selecionar uma das opções de valores (área, 

perímetro ou Ferret) 

 

 
Figura 30: Planilha de resultados com o menu selecionado 
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Figura 31: Caixa de diálogo para seleção de distribuição desejada 

 

Após selecionado o parâmetro desejado para a distribuição será  exibida a 

janela, Figura 32,  com o gráfico e valores referentes à distribuição dos tamanhos de 

grãos, como apresentados na Figura 30, os valores de Feret.  
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Figura 32: Janela portadora do gráfico de distribuição de Feret 

 

Na janela de Distribuição de Feret, Figura 32, existe um botão com a 

legenda “List”, que permite a exibição dos valores, destacado na Figura 33,  

utilizados para gerar o gráfico de distribuição de Feret. 

 

   

Figura 33: Janela com os valores utilizados para criar o gráfico de distribuição de Feret 
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APÊNDICE 2 

 

O plugin de circularidade “Circularity_.java”, que anteriormente calculava a 

circularidade de cada grão individualmente, foi alterado para calcular a circularidade 

de todos os grãos identificados. 

 

import ij.*;  
import ij.plugin.filter.*;  
import ij.process.*;  
import ij.gui.*;  
import ij.measure.*; 
public class Circularity_ implements PlugInFilter, Measurements  
{  ImagePlus imp;  

public int setup(String arg, ImagePlus imp)  
{  if (IJ.versionLessThan("1.18o"))  

return DONE;  
this.imp = imp;  
return DOES_ALL;  

}  
public void run(ImageProcessor ip)  
{        int measurements = Analyzer.getMeasurements();  

measurements |= AREA+PERIMETER;  
Analyzer.setMeasurements(measurements);  
Analyzer a = new Analyzer();  
ImageStatistics stats = imp.getStatistics(measurements);  
Roi roi = imp.getRoi();  
a.saveResults(stats, roi);  
ResultsTable rt =Analyzer.getResultsTable();  
int counter = rt.getCounter();  
double area = rt.getValue(ResultsTable.AREA, counter-1);  
double perimeter = rt.getValue(ResultsTable.PERIMETER, counter-1);  
rt.addValue("Circularity", 

perimeter==0.0?0.0:4.0*Math.PI*(area/(perimeter*perimeter)));  
a.displayResults();  
a.updateHeadings();  

}  
} 
 

Plugin de configuração de barra de escala “ScaleBar.java” alterado para que 

faça transformação das barras de micrometro e nanometrico para milímetros 

 

... 
public class ScaleBar implements PlugIn { 
… 
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void drawScaleBar(ImagePlus imp) { 
          if (!updateLocation()) 
            return; 
        Undo.setup(Undo.FILTER, imp); 
        drawScaleBar(imp.getProcessor(), getUnits(imp)); 
        imp.updateAndDraw(); 
    } 

... 

ip.resetRoi(); 
ip.setColor(color); 
ip.setRoi(x, y, barWidthInPixels, barHeightInPixels); 
ip.fill(); 
ip.resetRoi(); 
if (!hideText) 
            ip.drawString(label, x+xoffset, y+yoffset); 

… 

}//fim do arquivo 

 

Classe inserida no código fonte do software livre ImageJ, na classe 

“Result.java” com o plugin alterado para que faça a medição do valor do diâmetro de 

Feret de todos os grão identificados. 

  

drawFeretsDiameter(); 
macro "Draw Ferets Diameter" { 
    drawFeretsDiameter(); 
} 
macro "Analyze Particles and Draw" { 
    run("Analyze Particles...", "show=Nothing exclude clear record"); 
    drawAllFeretsDiameters(); 
} 
function drawAllFeretsDiameters() { 
    for (i=0; i<nResults; i++) { 
        x = getResult('XStart', i); 
        y = getResult('YStart', i); 
        doWand(x,y); 
        drawFeretsDiameter(); 
        if (i%5==0) showProgress(i/nResults); 
   } 
    run("Select None"); 
} 
function drawFeretsDiameter() { 
     requires("1.29n"); 
     run("Line Width...", "line=1"); 
     diameter = 0.0; 
     getSelectionCoordinates(xCoordinates, yCoordinates); 
     n = xCoordinates.length; 
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     for (i=0; i<n; i++) { 
        for (j=i; j<n; j++) { 
            dx = xCoordinates[i] - xCoordinates[j]; 
            dy = yCoordinates[i] - yCoordinates[j]; 
            d = sqrt(dx*dx + dy*dy); 
            if (d>diameter) { 
                diameter = d; 
                i1 = i; 
                i2 = j; 
            } 
        } 
    } 
    setForegroundColor(255,127,255); 
    drawLine(xCoordinates[i1], yCoordinates[i1],xCoordinates[i2],yCoordinates[i2]); 
} 
 

Classe que instancia o plugin “ScaleBar.java” para que possa ser utilizado o 

recurso de configuração do recurso de medição de acordo com a barra de escala. 

 

public class Scaler implements PlugIn, TextListener, FocusListener  
{ … 
 private static int interpolationMethod = ImageProcessor.BILINEAR; 
 private String[] methods = ImageProcessor.getInterpolationMethods(); 
 … 
 private double xscale, yscale, zscale; 
 … 
public void run(String arg) { 

… 
void scale(ImageProcessor ip) { 
  if (newWindow) { 
   Rectangle r = ip.getRoi(); 
   ImagePlus imp2 = imp.createImagePlus(); 
   imp2.setProcessor(title, ip.resize(newWidth, newHeight, 

averageWhenDownsizing)); 

   Calibration cal = imp2.getCalibration(); 
   if (cal.scaled()) { 
    cal.pixelWidth *= 1.0/xscale; 
    cal.pixelHeight *= 1.0/yscale; 
   } 
   imp2.show(); 
   imp.trimProcessor(); 
   imp2.trimProcessor(); 
   imp2.changes = true; 
  } else { 
   if (processStack && imp.getStackSize()>1) { 
    Undo.reset(); 
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    StackProcessor sp = new 
StackProcessor(imp.getStack(), ip); 
    sp.scale(xscale, yscale, bgValue); 
   } else { 
    ip.snapshot(); 
    Undo.setup(Undo.FILTER, imp); 
    ip.setSnapshotCopyMode(true); 
    ip.scale(xscale, yscale); 
    ip.setSnapshotCopyMode(false); 
   } 
   imp.killRoi(); 
   imp.updateAndDraw(); 
   imp.changes = true; 
  } 
 } 


